
1 / 43

PstViewer Pro User's
Manual



2 / 43

Table of contents

Introduction .................................................................................................................................... 2
System requirements .............................................................................................................. 3
Technical support .................................................................................................................... 4
About Us .................................................................................................................................. 4

User interface ............................................................................................................................... 4
Explorer tree ............................................................................................................................ 6
Favorites tree .......................................................................................................................... 7
Filter E-mails ........................................................................................................................... 9
Mail list ................................................................................................................................... 10
Message viewer .................................................................................................................... 12
Main menu ............................................................................................................................. 14
Search messages dialog ..................................................................................................... 18
Status bar .............................................................................................................................. 19
Command line parameters .................................................................................................. 20

Mail actions ................................................................................................................................ 23
Mail enumeration .................................................................................................................. 24
Mail exporting ........................................................................................................................ 24

Configuration .............................................................................................................................. 30
Settings .................................................................................................................................. 31
L10NTool.exe ........................................................................................................................ 32
File associations ................................................................................................................... 34
Print preview .......................................................................................................................... 35
Updating and update settings ............................................................................................. 36
Logging .................................................................................................................................. 37

Enterprise deployment .............................................................................................................. 37
Deployment ........................................................................................................................... 37
Registration ........................................................................................................................... 38
Command line switches ....................................................................................................... 39

Transferring activation ............................................................................................................... 42
Releasing license activation ................................................................................................ 42

Introduction

 
What is PSTViewer Pro?
 
PSTViewer Pro is an application for viewing and exporting MSG, EML, PST and OST files, including those
containing email messages, contacts and tasks. PSTViewer Pro does not require MAPI installed on
computer to work with PST and OST files. You can view message headers, bodies, attachments and
perform various actions on them including exporting them to different file formats.
 

PSTViewer Pro key features
· Viewing headers, bodies and attachments of messages in MSG, EML and PST formats.
· Support for reading PST and OST files without MAPI (Messaging Applications Programming Interface)

installed.
· Ability to view contacts, tasks, appointments, etc.
· Viewing messages with Plain Text, RTF and HTML bodies.
· Lots of possible actions for messages, such as Reply, Forward, Print, Export.
· Exporting messages to multiple formats with lots of possible export preferences.
· Advanced search, filtering and file system navigation system.
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· Highly customizable user interface with profiles support.
· Command line utility.
· Integration with Windows and default email client.
 

Supported message formats
· MSG - Microsoft Outlook message file; compatible with other programs that use Microsoft's Messaging

Applications Programming Interface (MAPI).
· EML - E-mail message saved by Microsoft Outlook Express, Thunderbird, Lotus, and other e-mail

programs; may also contain e-mail attachments, or files sent with the message.
· PST - Personal Storage Table, file format used to store local copies of messages, calendar events, and

other items within Microsoft Outlook.
· OST - Off-line Storage Table that stores e-mail messages and other data saved by the application from

an Exchange server.
 
 
If you have any comments or suggestions for improving PSTViewer Pro, we will be glad to hear your
feedback. Please address your comments to support@encryptomatic.com, Subject "PSTViewer Pro
Feedback”.
 

System requirements
 
Before installing PSTViewer Pro, be certain that your computer meets the following minimum software and
hardware requirements.
 

Requirement Description Note

Processor Recommended: 1 gigahertz (GHz)
processor

RAM Recommended: 512 MB

Available Hard Disk Space 55 Mb of available space required on
installation drive

Operating System Microsoft Windows XP Professional
SP3
Microsoft Windows Server 2003
Enterprise Edition SP2
Microsoft Windows Server 2008
Enterprise Edition SP2
Microsoft Windows Vista SP2
Microsoft Windows 7 SP1
 
Microsoft Windows XP Professional
x64 Edition SP2
Microsoft Windows Vista x64 SP1
Microsoft Windows 7 x64 SP1
Microsoft Windows Server 2008 x64
Enterprise Edition SP2
Microsoft Windows Server R2

Microsoft Windows 8 and 8.1 

Software Windows
Installer

Version 3.1 or later Checked and updated
automatically during
installation
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.Net framework Version 2.0 or later for x86 platforms
Version 3.5 or later for x64 platforms

Checked and updated
automatically during
installation

 
 
 

Technical support
 
We invite you to use the comment form on our website to submit bug reports, feature requests, and
usability comments. All submitted comments are reviewed by the product manager and given serious
consideration.
 
Visit www.encryptomatic.com/support.

About Us

Our Mission
To provide solutions that make our customers' lives more enjoyable and secure.

Our Vision
A safe world with the freedom to communicate freely and securely.

About Us
Encryptomatic LLC is a privately held limited liability company headquartered in the historic downtown
district of the twin towns of Moorhead, MN, and Fargo, ND USA, in heart of the beautiful Red River Valley
of the North, where we enjoy snowy winters, beautiful summers, clean air, great fishing and an abundance
of seasonal outdoor activities. Our average workday commute is about ten minutes.
 
We were founded in 2005 by our President, Darren Leno, a former Product Manager for Microsoft Business
Solutions, and Great Plains Software, Inc.
 
For more information, please visit http://www.encryptomatic.com/about-us/
 

User interface
 

http://www.encryptomatic.com/support
http://www.encryptomatic.com/about-us/
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Main window of PSTViewer Pro consists of following logical zones: Mail list, Message viewer, Explorer
tree, Favorites tree, Status bar, Toolbar and Main menu.
 
Explorer tree represents a tree of folders, available on your computer and network. Upon clicking on a
folder, containing messages in format, recognizable by PSTViewer Pro, these messages will be enumerated
and added to Mail list.
 
Mail list is a table, containing information about messages in active folder. Messages can be sorted, filtered
and grouped by their attributes.
 
Message viewer displays header, body and attachments of a message, selected in Mail list.
 
Status bar shows description of hovered user interface elements, name and status of current action, number
of messages in active folder and other information.
 
Toolbar and Main menu provide access to a number of application tweaks and customizations and can be
used to perform mail actions.
 
Refer to the topics about each of the interface elements for more detailed information.
 

Links
Explorer tree
Favorites tree
Mail list
Message viewer
Main menu
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Toolbar
Status bar

Explorer tree
 

 
Explorer tree represents a tree of folders, available on your computer and network. Upon clicking on a
folder, containing messages in format, recognizable by PSTViewer Pro, these messages will be
enumerated and added to mail list.
 
Explorer tree lists folders, remote computers and network shared folders. Messages located in one of
these places can be added to Mail list either by selecting item in a tree, or by right-clicking an item and
selecting Scan folder from context menu. If Scan folder with subfolders item is checked, messages in
subfolders will be also enumerated.
 
You can refresh folder tree to update display of recently renamed, created or deleted items by clicking 
Refresh button on the toolbar or by selecting it in the context menu.
 
Open in explorer context menu item and toolbar button are used for opening selected folder in Windows
explorer.
 
Properties context menu item and toolbar button shows standard system properties dialog for selected
folder.
 
Add to favorites toolbar button adds selected folder to active node of the favorites tree.
 
Docking functionality can be used to change the default position for the Explorer tree.
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Links
Favorites tree
Mail list
Mail enumeration
Docking Functionality

Favorites tree
 

 
Favorites tree is a structure that allows quick access to frequently used folders and messages.
Messages located in one of the folders can be added to Mail list either by selecting item in a tree, or by
right-clicking an item and selecting Browse or Browse with subfolders from context menu.
 
To add folder to favorites, select it in the Explorer tree and click Add to favorites button on the toolbar.
Messages can be added to favorites by dragging them from Mail list into the necessary location in the
Favorites tree.
 
Folders can be manually created in the tree by selecting a node and clicking New folder in the context
menu. New folder will be created as a child of the selected item.
 
Edit item name context menu item can be used to change selected folder's name.
 
Delete context menu item is used for deleting folders in the tree.
 
Docking functionality can be used to change the default position for the Explorer tree.
 

Links
Explorer tree
Mail list
Mail enumeration
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Docking Functionality
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Filter E-mails

Filter E-mails
 
The Filter E-mails editor allows you to filter data (display those emails that meet specific requirements),
by visually constructing filter criteria in a straightforward graphical form. 

The Filter E-mails editor is used to edit filter criteria. To create and customize filter criteria, use the
buttons embedded into the control and context menus supported by the editor's elements.

Add Conditions

To add a condition to a logical group, do one of the following:

    Focus any condition within the group or the group's logical operator and then press INSERT. 
    Click the  button for the group.
    Click the group's logical operator and select Add Condition.

Delete Conditions

To delete a condition, do one of the following:
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    Focus the condition and press DELETE.
    Click the  button.

Edit a Condition's Value

To edit a condition's value, click the operand value and type text.

To activate the operand value's edit box without changing the value, click the value or focus the operand
value via the keyboard and press F2, SPACE, ENTER or ALT+DOWN

To close the active edit box, press ENTER.

To discard changes to the value and close the active edit box, press ESC.

Apply Filter

Click "Apply" to filter data using the created filter condition.

Clear Filter

To clear filter, click "Clear filter" button.
 

Links
Favorites tree
Explorer tree
Mail list

Mail list
 

 
Mail list is a table, containing information about messages in active folder. Messages can be sorted, filtered
and grouped by their attributes.
 
Mail list contains following columns: selector column, file type icon column and message attributes
columns: subject, from, to, CC, BCC, delivery time, submit time, has attachments, internal path, source
format, source path. User can select which columns to show in the table and which to hide.
 
Icons displayed for the messages in Mail list help to differentiate between file types of the messages and
the presence of attachments.
 

Context menu
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Right-clicking on a line in mail list table brings context menu for selected message.
 
Open message context menu item is used to open selected message in a default email client.
 
Mail list view context menu item allows disabling of filtering and grouping capabilities of Mail list
component in case user does not need them.
 
Save context menu item allows user to save selected message in the specified folder preserving the same
file name this message already has.
 
Save message as... context menu item allows user to save selected message in the specified folder with
custom file name.
 
Export context menu item performs export action on selected message. User will be prompted to select
and/or customize export profiles.
 
Properties context menu item displays Mail information dialog which shows information about message
header and file properties and allows to view message's raw transport header and MAPI properties tree.
 
Note: Open message, Save message as... and Properties menu items are unavailable when multiple
messages are selected.
 

Advanced Mail list tools
 
Mail list provides powerful tools for sorting, filtering, grouping messages and column management.
 
You can select which columns to display in the table by clicking Column Chooser in header context menu
and dragging required columns from Customization window to the table. The order of the columns can also
be changed using drag and drop.
 
 
The simplest way to create filter is to enter a value in one of the fields above the table. The contents of the
table will be filtered according to the inputted data in the corresponding column. Resulting filter can be seen
the the bottom of the table. It can be disabled and cleaned by unchecking checkbox near its description or
clicking [x] button.
 
Another way to filter messages is clicking filter button in the column header (visible when mouse is hovering
the header). It will bring a list of possible values for filter current column. This list will differ depending on
column data type. For example, for subject column filtering values would include "Blank fields", "Non-blank
fields", list of subjects of messages currently in the table and custom filter editor. For received time column
filter would allow selecting date from Date picker control or selecting one of the predefined time-filtering



12 / 43

options like "Earlier this year" or "Last week".
 
Any of the earlier created filter rules can be picked from list, that will appear after clicking on the current filter
rule.
 

 
Filter editor dialog can be used for more advanced filtering rule editing. It can be used either to create filter
from scratch or to modify already created filtering rule. Filter editor can be called by selecting Filter
editor... in column header context menu or by clicking Edit filter button in right bottom corner of the Mail
list if filter is already created.
 
Filter editor creates logical constructs that are used for table filtering. These constructs are one or several
logical conditions united by one of the logical operations (AND, OR, NOT AND, NOT OR). Logical conditions
consist of comparisons contents of the columns with proposed value.
 
 
Message grouping can be done by the values of one or several columns in the table. To perform grouping,
drag the column header into to grouping panel. It is possible to perform grouping by several columns. In this
case, nesting order of the grouping columns will be determined by their relative position in grouping panel. It
can be changed by dragging column headers inside of the grouping panel. To cancel grouping, drag column
headers back into the table.
 
Docking functionality can be used to change the default position for the Explorer tree.
 

Links
Explorer tree
Favorites tree
Message viewer
Mail actions
Mail enumeration
Docking Functionality

Message viewer
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Message viewer displays header, body and attachments of a message, selected in Mail list.
 
Message viewer consists of two main parts - Message header viewer and Message body viewer.
 

Header viewer
 
Message header viewer displays attributes from message header (sender, recipient, CC and BCC fields,
sent and delivery times) and attachments list.
 
Clicking on header fields, containing email address, will result in creating a message in default email client
with selected address as recipient.
 
Clicking on attachment items, opens them in a default application associated with corresponding file types.
Right-clicking on attachments brings context menu for selected object.
 
Open attachment context menu item is used to open selected attachment in a default application (same
action as clicking on item).
 
Open with... attachment context menu item brings Open with system dialog, that allows user to specify
which application will be used to open this attachment (and optionally other files of this type).
 
Save attachment context menu item allows user to save selected attachment item in the specified folder
preserving the same file name this attachment item already has.
 
Save As... attachment context menu item allows user to save selected attachment item in the specified
folder with custom file name.
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Save All attachment context menu item allows user to save all attachment items in the specified folder
preserving the same file names these attachment items already have.
 

Message body viewer

Message header and body can be viewed in separate window if double-clicked in Mail List.

 
Message body viewer displays body of email message. It is displayed with all available formatting, unless
Use plain text option is activated.
 
User can select message body and copy it into different application. If that application supports rich text
editing (i.e. MS Office applications) source formatting of message body will be preserved.
 
Right-clicking on message body displays context menu.
 
Select All message body context menu item selects all text in the message body.
 
Copy message body context menu item is used to copy selected text of the message body into the
clipboard.
 
View source message body context menu item opens file, containing source code of the selected message
in Notepad.
 
Docking functionality can be used to change the default position for the Explorer tree.
 

Links
Mail list
Mail actions
Docking Functionality

Main menu
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Main menu of PSTViewer Pro consists of 5 top-level menus - File, Mail, Export, View and Help.
 
Please note, that main menu is completely customizable. This article describes elements in order they are
grouped by default. Check User interface tweaks article for more information.
 

File menu
 

 
File menu contains following items:
 
Open menu item is used to open message file of one of the supported formats in PSTViewer Pro. Messages
contained in selected file will be listed in mail list.

Print menu item prints selected message using default printer and default printing settings.

Print preview menu item opens Preview window that allows various settings and customizations related to
the process of printing. Check Print preview article for more information.

Settings menu item brings Settings dialog, that allows user to set font used in application and interface
reactivity time. See Settings article for more details.
 
Associations menu item allows user to associate MSG, EML and PST files with PSTViewer Pro. See File
associations article for more details.
 
Exit menu item closes all messages opened in PSTViewer Pro and quits the application.
 

Mail menu
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Mail menu contains following items:
 
Open message menu item is used to open selected message in a default email client.
 
Save menu item allows user to save selected message in the specified folder preserving the same file name
this message already has.
 
Save message as... menu item allows user to save selected message in the specified folder with custom
file name.
 
Delete menu item closes all messages opened in PSTViewer Pro and quits the application.

Properties menu item displays Mail information dialog which shows information about message header
and file properties and allows to view message's raw transport header and MAPI properties tree.
 
Select All menu button selects all emails shown in Mail List window

Search menu item opens Search window
 
Reply menu item opens default email client with a reply to a sender of a selected message.
 
Forward menu item opens default email client, forwarding selected message to selected recipients.

Note: see Mail actions section for more information about each of the actions, performed by items of Mail
menu.
 
Note: only Search menu item is available when no messages are present in mail list. Open message,
Save message as..., Reply and Properties are unavailable when selecting multiple messages.

Export menu
 

 
Export menu contains following items:
 
Add to a PDF file adds selected messages to PDF file.
 
Export menu item performs export action on selected message. User will be prompted to create, select
and/or customize export profiles.
 
Edit profile menu item allows user to change predefined profiles settings.
 
New profile menu item allows to create new profiles.
 
Delete profile allows to delete currently active export profile.

Restore defaults allows user to reset export profiles settings to default.
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View menu
 

View menu contains following items:
 
Use plain text body menu item switches display of all messages in Message viewer to plain text body. In
plain text mode, contents of message body will be displayed without formatting.
 
Rotate Layout menu allows to rotate Mail List and Message viewer panels.
 
Flip Layout menu allows to swap Mail List and Message viewer panels if they are displayed vertically.
 
Navigation allows user to switch between Explorer tree and Favorites.
 
Appearance menu item allows user to choose various skins for PstViewer Pro.
 
 

Help tab menu
 

 
Help menu contains following items:
 
Help menu item opens user's guide.

Connect with us opens webpage where user can find more information or contact support team.

About menu item shows windows with information about PSTViewer Pro and your license key.

Registration menu item opens dialog that allows to register your copy of application.
 
Buy now menu item opens a webpage where user can purchase a copy of PSTViewer Pro. The page will be
opened in default browser.
 
When Start logging menu item is selected, application starts logging internal information into log file. (User
will be asked to specify its name and location) This file can be later sent to technical support to help
resolving problematic situations. See Logging article for more information.
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Open log file menu item opens log file, generated after selecting Start logging command, in default text
editor.
 
Check for updates menu item checks in newer version of PSTViewer Pro is available.
 
Update settings menu item opens configuration dialog for updater. See Updating and update settings for
more information.
 

Links
User interface tweaks
Message viewer
Docking Functionality
Mail actions
 

Search messages dialog
 

 
Search messages dialog is used to search contents of messages.
 
On Search tab user enters text in Text to search field. The specified text is searched for in message
headers and bodies.
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On Advanced tab it is possible to specify in which part of message to perform search. Text can be
searched for in From, Subject, CC, From message properties, the whole Header text or Message
body.
 
Date block is used for date-limited searches. User can specify Start Date, End Date fields or both of
them to provide time limitation for searches. Please note, that value in End Date field should always be
later than value Start Date.
 
If Include subfolders in search option is checked, search will be performed recursively in specified folder
and its subfolders. Include *.eml and Include *.msg checkboxes allow limiting searches only for files of
certain type.

Match case enforces that hits have exactly the same case as the query. If this is disabled, the search is
case insensitive.

Match whole word only will only result in a hit if the match consists of an entire word, not if it's partial
(for example (but not limited to), whitespace separated). 

In Regular Expression, the query will be handled like a regular expression.

List of special characters:

. - any character
\w - word character (letter or digit)
\d - decimal digit
\s - white-space character (space or tab)
* - 0 or more matches of the previous element
+ - 1 or more matches of the previous element
? - 0 or 1 match of the previous element
[ ] - group of symbols, for example [ABC]+ CAB - matches, CAD - doesn't match
\ - escape character "\." if you need dot symbol
| - OR operator, th(e|is|at) matches "the" and "this" in "this is the day"

After Match whole word only and Use regular expressions checkboxes are set to be active, Regular
expression will be searched among separate words of text that meets searching results. Modificators (‘ '̂,
‘$', \b) will be removed in case they were previously used.

 
For more detailed criteria of searching for messages, please see filtering options of Mail list.
 

Links
Mail list
Mail actions
Mail enumeration

Status bar
 

 
Status bar shows description of hovered user interface elements, name and progress of current action,
number of messages in active folder and other information.
 

Links
User interface tweaks
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Toolbar
Mail enumeration

Command line parameters
 
Command line interface of PSTViewer Pro can be accessed via PSTViewerConsole.exe file, located in the
same directory as PSTViewer.exe.
 
 
Usage: PSTViewerConsole.exe [options] [<file1> [<file2> ...]]
 
Options description:
 
 
h, help      
Show usage description.
Usage: PSTViewerConsole.exe --help
 
 
a, associate
Associate specified file extensions with application.
Usage: PSTViewerConsole.exe --associate <format[s]>
 
 
p, print
Print specified message to default or specified printer.
Usage: PSTViewerConsole.exe --print <file[s]>
 
 
e, export
Export messages with predefined profile.
Usage: PSTViewerConsole.exe --export <profile> <file[s]>
 
Example:
"C:\Program Files\Encryptomatic, LLC\PSTViewer Pro\PSTViewerConsole.exe" --e
"PDF - attachments converted/included" "C:\your_file.msg"
 
"C:\Program Files\Encryptomatic, LLC\PSTViewer Pro\PSTViewerConsole.exe" --e
"PDF - attachments converted/included" "C:\your_folder_with_messages"
 
Customize export for PST/OST.
To specify extended format please add the next fields to the end of path:
{1} {2} | {3}
where:
{1} = :: [begin extended command]
{2} = <internal path inside PST/OST file> [for example: \Indox\John Doe] | [delimeter]
{3} = T or F [T - export with subfolders (recursively), F - export without subfolders]
 
All parts are mandatory if :: is specified after file path.
 
Example:
Export Inbox folder from pst file (without subfolders):
"C:\Program Files\Encryptomatic, LLC\PSTViewer Pro\PSTViewerConsole.exe" --e
"PDF - attachments converted/included" "C:\your_psf_file.pst::\Inbox|F"
 
Export Inbox\NewFolder folder from pst file with subfolders:
"C:\Program Files\Encryptomatic, LLC\PSTViewer Pro\PSTViewerConsole.exe" --e
"PDF - attachments converted/included" "C:\your_psf_file.pst::\Inbox
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\NewFolder|T"
 
 
c, command
Load command line switches from specified file.
Usage: PSTViewerConsole.exe --command <file>
 
 
w, nobrowse
Disable messages loading at startup.
Usage: PSTViewerConsole.exe --nobrowse
 
 
r, runprofile
Choose profile with GUI layout.
Usage: PSTViewerConsole.exe --runprofile <profile name>
 
 
l, log
Turn on the log file.
Usage: PSTViewerConsole.exe --log <file>
 
 
i, printer
Specify default printer.
Usage: PSTViewerConsole.exe --printer <name>
 
 
k, key
Register the application with specified serial key for current user. Key will be applied during next start of
application.                
Usage: PSTViewerConsole.exe --key <serial key>
 
m, mkey
Register the application with specified master key for local machine. Key will be applied during start of
unregistered application. Administrative privileges are required for this command.                  
Usage: PSTViewerConsole.exe --mkey <serial key>
   
       
delkey
Erase serial key for current user.
Usage: PSTViewerConsole.exe --delkey
 
delmkey
Erase master key for local machine. It will not influence already registered copies, but for new users the
application will be unregistered.
Usage: PSTViewerConsole.exe --delmkey
 
 
g, gui or GUIFLAGS
Configure visibility of GUI elements.
Usage:
PSTViewerConsole.exe --gui <element1,element2[,...]>
or
PSTViewer.Setup-5.x.x.xxxx.exe GUIFLAGS="<element1,element2[,...]>
 
PSTViewer GUI elements:
· MLP - Mail list panel
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· FEP - File explorer panel
· FTP - Favorites tree panel
· TBR - Toolbar
· MMP - Main menu panel
· SCH - Search elements
· CMZ - Customize GUI elements dialog
· NUP - Remove 'Check fro updates' and 'Update settings' options from the Help menu.
 
Toolbar buttons:
· OPF - Open file
· REP - Reply message
· FWD - Forward messages
· PRN - Print messages
· EXP - Export messages
 
 
UPDATE_POLICY
Choose update policy.It can be found in Help menu.
Usage: UPDATE_POLICY="Never" | "Ask" | "Auto"
 
Options for update policy:
· Never - Set 'Do not check for updates automatically' options in 'Updates Options' dialog;
· Ask - Set 'Check and prompt me to download and install the updates' options in 'Updates Options'

dialog. This option is set by default;
· Auto - Set 'Check and automatically download and install' options in 'Updates Options' dialog.
 
 
GUILANG
Set the language for PSTViewer Pro interface.
Usage: GUILANG="<language>"
 
The list of languages that PSTViewer Pro supports:
1 Chinese.zh-CN
2 Chinese.zh-TW
3 English.en-US
4 French.fr-FR
5 German.de-DE
6 Italian.it-IT
7 Polish.pl-PL
8 Portuguese.pt-PT
9 Russian.ru-RU
10Spanish.es-ES
 
 
/exelang
Set the language for installation process.
Usage: /exelang <LangId>
 
The table with different <LangId> can be found here:
http://msdn.microsoft.com/en-us/goglobal/bb964664.aspx
 
Example (to install French version):
PSTViewer.Setup.exe /exelang 1036
 
 
<file_extension>_ASSOC
Associate PSTViewer with msg, eml, pst or/and ost files.
Usage:
· EML_ASSOC="1" - associate PSTViewer Pro with eml files;

http://msdn.microsoft.com/en-us/library/bb165625%28VS.80%29.asp
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· MSG_ASSOC="1" - associate PSTViewer Pro with msg files;
· PST_ASSOC="1" - associate PSTViewer Pro with pst files;
· OST_ASSOC="1" - associate PSTViewer Pro with ost files;
· ALL_ASSOC=1 - associate PSTViewer Pro with msg, eml, pst an ost files.
 
 
Usage:
msiexec /i PSTViewer.Setup-5.x.x.xxxx.msi /qn PIDKEY="xxxxxxxx-xxxx-xxxx-
xxxx-xxxxxxxx" GUILANG="French.fr-FR" GUIFLAGS="FWD,REP,FTP" ALL_ASSOC=1
 
or
PSTViewer.Setup-5.x.x.xxxx.exe /qn PST_ASSOC="1" MSG_ASSOC="1"
GUIFLAGS="FWD,REP,FTP,NUP"
 
 

Links
User interface tweaks
User interface
 

Mail actions
 
Mail action is an operation that can be performed on messages or message groups. Some actions can be
performed on single messages only and some - on several messages.
 
Any actions that take time to perform can be stopped by pressing Stop button on the Toolbar.
 
 
Mail actions include:
· Opening
· Replying
· Forwarding
· Printing
· Exporting
· Saving
· Deleting
· Enumerating messages in folders
 
 
Opening. Opens message in default email client action.
 
Replying. An action of replying consists of creating a message following selected message in a default
email client. Sender of original message with be recipient of the new one.
 
Forwarding. An action of forwarding consists of creating a message in a default email client, containing
the copy of the original message to allow to forward it to different recipient.
 
Printing. An action of printing messages. Printing scale, paper size, background color, watermarks and
other options can be customized in Print preview window. Check Print preview article for more
information.
 
Saving. An action of saving a copy of selected message in specified folder. File name my be taken from
source message or specified directly.
 
Deleting. An action of deleting of selected messages. Messages inside containers (PST files) cannot be
deleted.
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Exporting. An action which consists of saving selected message or messages to one of file formats
according to specified export profile settings. See Mail exporting article for more details.
 
Enumerating. An action of retrieving a list of messages located in specified folder and (optionally) its
subfolders. See Mail enumerating article for more details.
 

Links
Mail enumeration
Mail exporting
Main menu
Toolbar
Mail list

Mail enumeration
 
Mail enumeration is an action of retrieving a list of messages located in specified folder and (optionally) its
subfolders. A result of enumeration is a Mail list filled with information about messages in current location.
 
Enumeration is automatically triggered when user selects a folder in Explorer tree or Favorites trees. It
can be manually triggered by selecting Refresh in Explorer tree context menu or Browse or Browse
with subfolders in Favorites tree context menu. In case of "with subfolders" option was selected,
enumeration will be performed in specified folder and recursively in all of its subfolders. Automatically
triggered enumeration will be performed recursively if Switch to scan with subfolders in Explorer tree
context menu is checked.
 
The length of the process of enumeration depends on the number of messages in the folder. If the process
takes a noticeable amount of time, its progress will be displayed in status bar. The displayed information
include progress bar with status of the process, estimated completion time and estimated number of
messages found. Please note, that during the enumeration of PST files, we cannot precisely pinpoint the
amount of messages inside, until the reading of file is complete. So, estimated amount of messages can
differ from exact number after the reading is complete.
 

Links
Mail actions
Explorer tree
Favorites tree
Mail list

Mail exporting
 
Mail exporting is an action, which consists of saving selected message or messages to one of file formats
according to specified export profile settings.
 
Exporting is done according to export profiles. Export profiles store all the settings needed for message
exporting. For example, they store information about format the export will be done to, destination folder, file
names generation and lots of others. You can have several export profiles and quickly switch between them
without having to set up all the options from a scratch.
 
There can be many export profiles, but only one could be active. Export is always done according to rules
and settings defined in the active export profile.
 
If you have export profiles already set, exporting messages can be performed simply by selecting messages
you want to export, pressing export button and selecting Start in Export Manager dialog.
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Supported export formats
· PDF - Portable Document Format, created by Adobe Systems for document exchange. PDF is used for

representing two-dimensional documents in a manner independent of the application software, hardware,
and operating system.

· HTML - Hypertext markup language file; can be opened by any web browser, such as Microsoft Internet
Explorer or Mozilla Firefox.

· MHT - Web archive MHTML file; supported by Microsoft Word, Internet Explorer or Opera.
· TXT - Plain text file format; can be opened and edited by any text editor.
· PNG - Portable Network Graphics, a bitmap image format that employs lossless data compression.
· JPG - A commonly used method of compression for photographic images.
· GIF - A bitmap image file format.
· TIFF - A file format for storing images, including photographs and line art.
· CSV -  A file format used for the storage of data structured in a table with comma-separated values.
· Source format - Export message in the same format as source message was stored in.
· Only attachments - Do not export message body, only attachments.
 

Export tools
 

 
Export tools panel allows user to select active export profile for export and to create, modify and delete
export profiles.
 
New profile button launches New export profile setup wizard that allows user to generate new export
profile in two steps.
 
Edit profile button opens Export profile editor dialog which can be used to modify settings of active
profile.
 
Delete profile button deletes active export profile. A confirmation for deletion will be asked.
 
After pressing Start button, the export of the messages will be started according to settings of active profile,
selected in Export Profiles drop-down list.
Pressing Cancel button will close Export manager dialog without starting the process of export.
 

New export profile setup wizard
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New export profile setup wizard provides a fast a simple way of generating new export profiles. On the
first step user is prompted to specify export profile name and export format. On second step storage of
output files can be specified - folder or zip file. If folder or file name are defined, they will be used in export
profile. If not - they will be asked during export. Pressing Finish button concludes export profile generation.
More advanced profile settings can be changed by selecting created profile in Export manager dialog and
pressing Edit profile button.
 

Export profile editor dialog
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Export profile editor dialog is used to modify settings of export profiles. The majority of settings are
common for all formats, but there are some format-specific, like page sizes. The detailed explanation of
export settings is listed below.
 

Common settings
 

Setting name Possible values Description

Target Format PDF, HTML, MHT, TXT, PNG, JPG, GIF,
TIFF, CSV,  Source format, Only
attachments

File format of the exported
messages.

Attachments Do not export, As file attachments in
subfolder, As file attachments in same folder

Message attachments
export type

Zip target Checked/Unchecked Compress each exported
item into zip archive

ZipLevel None, Low, Medium, High The level of compression.
Higher levels of compression
require more time to create



28 / 43

ZipPasswd Password for zip file

Groupi
ng

File naming Same filename as email file, Custom naming
schema

Exported items file name

File naming
schema

Setup the advanced file
naming schema. See 
Export file naming
schema editor section
below.

Action on empty
file name

Ask, Fill with index string Action for empty generated
file name

Reposi
tory

Repository for
result files

Folder, Zip Exported item location

RootFolder Folder to save items to. Will
be prompted if empty.

ZipFile Zip file name to save items
to. Will be prompted if
empty.

ZipLevel None, Low, Medium, High The level of compression.
Higher levels of compression
require more time to create

ZipPasswd Password for zip file

Misc. OnExistingFile AddSuffix, Overwrite, Ask Action for existing files

StopOnError Checked/Unchecked Stop export on error

CopyFailedTo Folder to save messages
that have failed to be
exported. Copying will be
skipped if empty.

 

Format-specific settings
 

Forma
t

Setting name Possible values Description

PDF PageSize UserDefined, Letter, A4, A3, Legal, B5, C5,
8x11, B4, A5, Folio, Executive, EnvB4,
EnvB5, EnvC6, EnvDL, EnvMonarch, Env9,
Env10, Env11

Page size of output PDF
file. If UserDefined in
selected, page size will be
taken from
CustomPageWidth and
CustomPageHeight
properties.

CustomPageWidt
h

Page width in points (1/72
inch)

CustomPageHeig
ht

Page height in points (1/72
inch)

Orientation Portrait, Landscape Use Portrait for pages with
height greater than width,
otherwise - Landscape.
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HTML Title HTML document title. (Tag
<TITLE>)

PNG
BMP
JPG
TIFF
GIF

Scale 1-1000 Scale of image in percents
(from 1 to 1000, default 100)

LockAspectRatio Checked/Unchecked Lock the ratio of width to
height of the image when
resizing

Height Height of the destination
image in pixels, overrides
Scale and LockAspectRatio.
Leave empty for default
image size.

Width Width of the destination
image in pixels, overrides
Scale and LockAspectRatio.
Leave empty for default
image size.

JPG Quality 1-100 Jpeg compression quality in
percents (from 1 to 100,
default 90)

CSV Encoding Ansi, UTF-8, Unicode Encoding of the contents of
CSV file

Separator ",", ";" Fields separator symbol

Export body Checked/Unchecked Include body as separate
field

 
 
Attachments

Attachments combo-box contains possible formats for message attachments export.

 

Value Description

Don't export Message attachments will not be exported

As file attachments in
subfolder

Message attachments will be saved as separate files in the subfolder of
the same directory as message body is

As files attachments in same
folder

Message attachments will be saved as separate files in the same
directory as message body is

As embedded attachments in
document

Message attachments will be embedded to the document as
attachments (PDF only)

As converted and included
content

Message attachments will be converted to the document format and
included as content (PDF only)

 

Export file schema editor dialog
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Export file schema editor dialog can be called when user has selected Custom naming schema in File
naming option. Export file schema editor dialog allows to generate folder tree in output folder and
customize output file name using elements with message attributes.
 
Available elements include:
· From - Name and address of message sender.
· To - List of message recipients. Can be adjusted to CC or BCC.
· Subject - Subject field of message
· Increment - 'Bates Stamp'-style naming convention of files
· Source - Transfer name of email file or email file format (MSG, EML or PST)
· Internal Path - Internal path of the message, for example /Inbox folder in email client
· Sent - Date and time when message was submitted
· Received - Date and time when message was received
· Exported - Date and time of export operation
 
To add element to current naming schema, drag and drop it to edit box of double click on it. After adding
element to naming schema, click on it to select possible customization options for those elements that
have them. Drag and drop can be used to change the order of the elements in the naming schema.
Any text can be manually added to the edit field to make it a constant part of the custom naming schema.
 
Use "\" symbol as a separator to define folders.
 
 

Links
Mail actions
Mail enumeration

Configuration

Configuration settings are described in this topic, such as:

· Settings - global application settings, such as font, language and date format
· L10NTool.exe - tool, that allows to add and modify language settings
· File associations - PSTViewer Pro can be set as a default application to open MSG, EML, PST and OST

files
· Print preview - advanced configuration options for printing files
· Updating and update settings - parameters of automatic updating
· Logging - recording of internal information into the text file
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Settings
 

 
Settings dialog contains global application settings. It can be called from Settings item in the File menu.
 
Application font drop-down list can be used to specify the font that will be used in application as an
interface font. It is vital, that an Unicode font is selected for correct display contents of messages with
non-english symbols. Arial Unicode MS is set as a default font.
 
Delay before displaying message options are used to set up optimal response time. This is the delay
time after the message was loaded after its selection in Mail list and before appearance of its contents in
Message viewer. Lower values will cause message to appear more quickly, higher values will make
navigation through Mail list more smooth.
 
Possible values - disable, or from 100 to 2000 ms. Default value - 400 ms.
 
Language drop-down list can be used to change GUI language for PVP. The current version supports the
next languages:
 
· English;
· French;
· German;
· Italian;
· Polish;
· Portuguese;
· Russian;
· Spanish;
· Chinese Traditional;
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· Chinese Simplified;
· Arab;
· Ukrainian;
· Norwegian;
· Hindi;
· Filipino.

If you do not see a specific language, you can localize PVP by your own using L10NTool.exe

Links
Main menu
User interface
Mail list
L10NTool.exe

L10NTool.exe
We provide L10NTool.exe with PVP installation (you can find it in PSTViewer Pro folder). After running this
tool you will get the next window:
 

 
 
Toolbar
 
Open button
 
Open button will display the next window:
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Choose Source file (the file that should be localized) and Target file (the file that will contain localized
information). Click Ok button. Now you can easily find the strings that are not localized (they are marked as
yellow strings):
 

 
 
To edit string you can double click on it:
 

 
 
Save and Save as...
 
Allow to save created document.
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Export untranslated
 
You can export all untranslated strings to one file. To do it click Export untranslated button:

 
 
Import
 
Import option allows to replace the strings in the opened file to strings in a new file:

 
 

Links:

Settings

File associations
 

 
File associations dialog contains global application settings. It can be called from Associations item in
the File menu.
 
PSTViewer Pro can be set as a default application to open MSG, EML, PST and OST files. File
associations can be set using standard Windows file association window.
 
Please note, that it is impossible to un-associate PSTViewer Pro with file types directly. To do this, you
should associate file types in question with different application using Windows file association interface.
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Links
Main menu
User interface
Mail list

Print preview
 

 
Print preview window provides advanced configuration options for printing files. It can be called from File
menu.
 
Features:
· Printer selection and preferences
· Printing preview, single- and multi-page. Custom zoom level.
· Saving and loading documents in prnx format
· Margins adjustments
· Setting of background colors
· Adding text or picture as watermark
· Saving document in picture file (BMP, JPG, GIF, PNG, TIFF, WMF, EMF)
· Emailing document in a picture file
 

Links
Main menu
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User interface
Mail actions

Updating and update settings
 

 
PSTViewer Pro has built-in system for checking if newer versions of application is available. User can
check for updates either manually, or allow application to do checks for newer versions periodically.
 
Manual update checks can be performed by pressing Check for updates item in Help menu. Parameters
of automatic updating systems can be set by selecting Update settings Help menu item.
 

Update options dialog

 
Check frequency group is used to set how frequently the check for updates is performed and if the
updates will be installed automatically.
 
If Do not check for updates automatically option is selected, PSTViewer Pro will never check for newer
versions automatically.
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If Check and prompt me to download and install the updates option is selected, application will
check for newer version with frequency, specified in Check frequency field. If the updates are found, user
will be asked if he wants to download and install these updates.
 
If Check and automatically download and install option is selected, PSTViewer Pro will check for
newer version with frequency, specified in Check frequency field. If the updates are found, they will be
downloaded and installed automatically (either all updates or critical only - as specified by user).
 
Downloads folders field sets the folder, in which temporary update files will be downloaded.
 
You can also set up update options while installation. Check Command line parameters article for more
information.
 

Links
Main menu
User interface
Command line parameters

Logging
 
Logging is recording of internal information into the text file. This file can be later sent to technical support
to help resolving problematic situations or report bugs with PSTViewer Pro.
 
Log contains basic information about user's operation system and internal information about application's
settings and performed actions. No personal information is collected.
 
Logging can be started by selecting Start logging item in Help menu. User will be asked to specify name
and location of the log file. After this, PSTViewer will log its activity until the application will be closed.
 
Generated log file can be opened by selecting Open log file item in Help menu. The log file will be
opened in default text editor.

Links
Main menu
User interface

Enterprise deployment

Enterprise deployment topic describes Deployment, Registration and Command line switches.
 
· Deployment - details about Installation Package
· Registration - information about PSTViewer Pro registration
· Command line switches - switches for .MSI Installer Package

Deployment

PSTViewer Pro installation is distributed as .EXE executable and as .MSI Windows Installer Package.
 
Executable version of installation is able to check if required components for PVP deployment are installed
in the system. If these dependencies are not installed, executable version will download and install them.
 
Installer Package version of installation is unable to download and install dependencies, but can be used
in remote software deployment systems. Please make sure, your PC meets minimum software
requirements before installing this version.
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Links
Registration
Command line switches 

Registration
This topic covers the aspects of PSTViewer Pro registration.
 
There are two different versions of PSTViewer Pro available - with and without copy protection system:
 
· Protected version of PVP require registration key to unlock full functionality. The software can be

evaluated with certain limitations without registering. The methods of registering application are
described below.
 

· Unprotected versions of PVP have NoLP as part of their installation file names. They can be installed
and used with full functionality for unlimited period of time without requiring input of the registration key.

 
All information below describes version of PSTViewer Pro with copy protection.
 
 
Trial limitations
 
Without key PSTViewer Pro has 15 days of free trial with a number of exported messages limited to 50
per export. After inputting a valid key these limitations are lifted.
 
 
Activation statuses
 
The activation status of current copy of PSTViewer Pro can be seen in Help - Registration. These statuses
include:
 
· Active trial version. User may evaluate PSTViewer Pro with trial limitations.

 
· Expired trial version. The trial period has expired, user must input registration key to continue using

PSTViewer Pro.
 
· Fully functional version. A valid registration key has been inputted. User may use PSTViewer Pro

without any limitations.
 
 
 
Methods of registration
 
1. Registration via command line.
 
You can register PVP via command line interface that can be accessed via PSTViewerConsole.exe file,
located in the same directory as PSTViewer.exe.
 
The next options are available for registration:
 
 
k, key
 
Register the application with specified serial key for current user. Key will be applied during next start of
application.                
 
Usage: PSTViewerConsole.exe --key <serial key>
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delkey
 
Erase serial key for current user.
 
Usage: PSTViewerConsole.exe --delkey
 
  
2. Registration via Registration window.
 
 
PSTViewer Pro can be registered manually via Help - Registration window. Write the key in Serial key field
and press Ok button. The registration procedure will be performed and if the key has been validated
successfully, the activation will be completed. You may require the internet connection to perform the
activation depending on your key type.
 
 
 
3. Registration while installation process.
 
 
You can register PSTViewer Pro for all users while installation process. The next option is available for
such registration:
 
PIDKEY="<license_key>"
 
 
Usage:
PSTViewer.Setup-5.x.x.xxxx.exe PIDKEY="xxxxxxxx-xxxx-xxxx-xxxx-xxxxxxxx"
 
or
msiexec /i PSTViewer.Setup-5.x.x.xxxx.msi /qn PIDKEY="xxxxxxxx-xxxx-xxxx-
xxxx-xxxxxxxx"
 
where xxxxxxxx-xxxx-xxxx-xxxx-xxxxxxxx is your license key.
 
 
Links
Deployment
Command line switches
Command line parameters
 
 

Command line switches
PSTViewer Pro installation files support all msiexec command-line options. For importing profiles via
command line, please see Profile deployment topic.
 
msiexec /Option <Required Parameter> [Optional Parameter]
 
Install Options
 
      </package | /i> <Product.msi>
 
              Installs or configures a product
 
      /a <Product.msi>
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              Administrative install - Installs a product on the network
 
      /j<u|m> <Product.msi> [/t <Transform List>] [/g <Language ID>]
 
              Advertises a product - m to all users, u to current user
 
      </uninstall | /x> <Product.msi | ProductCode>
 
              Uninstalls the product
 
Display Options
 
      /quiet
 
              Quiet mode, no user interaction
 
      /passive
 
              Unattended mode - progress bar only
 
      /q[n|b|r|f]
 
              Sets user interface level
 
              n - No UI
 
              b - Basic UI
 
              r - Reduced UI
 
              f - Full UI (default)
 
      /help
 
              Help information
 
Restart Options
 
      /norestart
 
              Do not restart after the installation is complete
 
      /promptrestart
 
              Prompts the user for restart if necessary
 
      /forcerestart
 
              Always restart the computer after installation
 
Logging Options
 
      /l[i|w|e|a|r|u|c|m|o|p|v|x|+|!|*] <LogFile>
 
              i - Status messages
 
              w - Nonfatal warnings
 
              e - All error messages
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              a - Start up of actions
 
              r - Action-specific records
 
              u - User requests
 
              c - Initial UI parameters
 
              m - Out-of-memory or fatal exit information
 
              o - Out-of-disk-space messages
 
              p - Terminal properties
 
              v - Verbose output
 
              x - Extra debugging information
 
              + - Append to existing log file
 
              ! - Flush each line to the log
 
              * - Log all information, except for v and x options
 
      /log <LogFile>
 
              Equivalent of /l* <LogFile>
 
Update Options
 
      /update <Update1.msp>[;Update2.msp]
 
              Applies update(s)
 
      /uninstall <PatchCodeGuid>[;Update2.msp] /package <Product.msi | ProductCode>
 
              Remove update(s) for a product
 
Repair Options
 
      /f[p|e|c|m|s|o|d|a|u|v] <Product.msi | ProductCode>
 
              Repairs a product
 
              p - only if file is missing
 
              o - if file is missing or an older version is installed (default)
 
              e - if file is missing or an equal or older version is installed
 
              d - if file is missing or a different version is installed
 
              c - if file is missing or checksum does not match the calculated value
 
              a - forces all files to be reinstalled
 
              u - all required user-specific registry entries (default)
 



42 / 43

              m - all required computer-specific registry entries (default)
 
              s - all existing shortcuts (default)
 
              v - runs from source and recaches local package
 
Setting Public Properties
 
      [PROPERTY=PropertyValue]
 
 
 
Consult the Windows ® Installer SDK for additional documentation on the command line syntax.
 
 
 
Links
Deployment
Registration
 
 

Transferring activation

Transferring activation topic describes how to release license activation in order to activate it again for
another user.

 
· Releasing license activation - how to release license activation in order to activate it again for another

user.

Releasing license activation

Releasing license activation using graphical interface

This option is available after successful PstViewer Pro registration and is used in order to transfer
PstViewer Pro activation to another user.

If you are changing computer or operational system, please release PstViewer Pro activation first.

To release activation for PstViewer Pro:

- Switch to "Help" tab;
- Click "Registration" button;
You will be prompted for confirmation about license release ("Are you sure you want to release the
license? Releasing the license will unregister this software so that you can activate it on another
computer. The software may stop working on this computer");
- Click "Yes".
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Releasing license activation from command line

Command line interface of PSTViewer Pro can be accessed via PSTViewerConsole.exe file, located in the
same directory as PSTViewer.exe.
 
Usage: PSTViewerConsole.exe [options] 

delkey
Erase serial key for current user.
Usage: PSTViewerConsole.exe --delkey

Links
Registration
Deployment
Command line switches
Command line parameters
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